BD FACSComp™ Software Tutorial

This tutorial guides you through a BD FACSComp software lyse/no-wash assay setup
run. If you are already familiar with previous versions of BD FACSComp software on
Mac® OS 9, refer to the BD FACSComp software (version 5.1 or higher) ReadMe file
for a description of new features. Additionally, refer to the ReadMe file for important
information about entering bead target values. ReadMe files are located in the
Documentation folder/Read Me Files folder on your hard drive.
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This tutorial covers:
e Preparing BD Calibrite™ beads
¢ Performing a lyse/no-wash assay setup run
¢ Optimizing settings for biological samples
e Using online Help
To perform the steps in this tutorial, you will need:

¢ A cytometer and a computer with BD FACSComp software version 5.1 or later

e BD Calibrite beads

e Optional: biological samples stained with BD Tritest™ or BD Multitest™
reagents, to be used for the optimization steps. Prepare samples as indicated in the
reagent package insert.

To ensure the instrument provides consistent results, run BD FACSComp software daily
using BD Calibrite beads. The software adjusts the electronics to place the beads at
target channel values. The software also measures the signal separation for each
parameter and compares this value to an expected minimum separation value. Logging
or exporting the summary data on a daily basis allows you to track instrument
performance over time.
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In addition to ensuring the instrument provides consistent results, BD FACSComp
software also generates instrument settings that can be used to collect data for human
lymphocyte cells.

Acquiring data on a cytometer is a multistep process. In this tutorial, we will focus on
performing instrument QC and optimizing instrument settings for biological samples
using BD FACSComp software.

Start Up Perform Optimize Acquire Analyze Shut Down
System > QC > Settings > Data > Data > System

NOTICE This tutorial demonstrates only the optimization steps necessary for a lyse/no-
wash sample stained with a BD Tritest or BD Multitest reagent. For information about
the other steps in the multi-step process, refer to the BD CellQuest™ Pro acquisition
and BD CellQuest Pro analysis tutorials.

Preparing BD Calibrite Beads

2

Following are general guidelines for bead preparation. For the most current preparation
instructions and additional information about BD Calibrite beads, refer to the
BD Calibrite beads package insert. Prepare beads immediately before use.

1 Label one 12 x 75-mm tube A and another B.

2 Add 1 mL of BD FACSFlow™ sheath fluid to tube A. Add 3 mL to tube B.
3 Mix the stock vials of beads by gentle vortexing.
4

Use the following table to prepare the bead tubes.

If you have a cytometer equipped with the FL4 option, prepare the four-color
setup. Otherwise, prepare the three-color setup. Add one free-falling, complete
drop of each of the beads based on the information in each column.

NOTICE If PerCP beads are included in the mixed bead suspension, beads are
stable for 1 hour on ice. For information on bead stability, refer to the
BD Calibrite beads package insert.

Setup Tube A Tube B
Three-color unlabeled unlabeled, FITC, PE, PerCP
Four-color unlabeled, APC unlabeled, FITC, PE, PerCP, APC

5 Cap the tubes and mix by gentle inversion.
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Performing Lyse/No-Wash Assay Setup

BD FACSComp software offers five assay choices that can be run one after another:

Lyse/wash (LW) assay for running lysed and washed samples stained with
multicolor reagents containing the PerCP fluorochrome

LW PerCP-CyS5.5 assay for running lysed and washed samples stained with
multicolor reagents containing the PerCP-Cy5.5 fluorochrome

Lyse/no-wash (LNW) assay for running samples stained with BD lyse/no-wash
multicolor reagents containing the PerCP fluorochrome

LNW PerCP-Cy5.5 assay for running samples stained with BD lyse/no-wash
multicolor reagents containing the PerCP-Cy35.5 fluorochrome

HLA-B27 calibration for HLA-B27 applications

BD FACSComp software uses BD HLA-B27 calibration beads and modifies the
settings from an LW assay.

NOTICE Use the LW assay for two-color samples and for applications other than those
described above.

For this tutorial, we will set up for a Lyse/No-Wash assay. When LNW is chosen,
instrument settings generated after the completion of the BD FACSComp software run
is saved to a file called Calib File. LNW. The file is stored in a folder called Instrument
Settings Files (BD Files/Instrument Settings Files). You can use these settings to run
samples prepared with BD Multitest or BD Tritest reagents.

1

Launch BD FACSComp software by clicking the application icon in the Dock.

FACSComp icon in Dock

If the icon is not in the Dock, you can place it in the Dock as follows:

¢ Display the FACSComp Folder in the BD Applications folder. See Figure 1-1
on page 4.
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Figure 1-1 FACSComp folder

¢ Drag the BD FACSComp software icon to the Dock.

Entering Information in the Sign In and Set Up Views

menu bar

icon bar

|0

Message: Welcame ba FACSCame Saftware. Pleast sign .

message box

Operator: |

[ ]
Lab Director: | ]
Cytometer Serial Number: 0123456789
Cytometer Model: FACSCalibur

content area

button panel

1 Fill in the Operator field.

Only the Operator field is required. Entries in Institution and Laboratory are

optional.
2 Click Accept or press Return.
3 Select the Lyse/No-Wash (LNW) checkbox under Assay Selection.

4 Fill in the Calibrite Bead lot IDs.

Enter all five of the BD Calibrite bead lot IDs. Lot IDs are required for all of the
beads to be used for the current setup. The bead lot ID, consisting of five numbers
and one letter, is found on the kit flyer in the box containing the beads. Do not
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add a space between the numbers and letter. The ID suffix is case sensitive; type
capital letters.

5 Enter 300 as the Lyse/No-Wash FL3 Threshold value, if necessary.

If you know the usual threshold value for your application, you can enter it here.
The value entered for threshold is saved in the Calib File. LN'W.

6 Click the Lyse/No-Wash Summary Report File checkbox.

The Summary Report file is a text file that contains the instrument settings and
Sensitivity Test results of the software run as reported in the Summary Report. It
does not contain the histograms. The default name of the report is
DDMMYY.sum or DDMMYY.LNWsum. The default location is the FACSComp
folder in the BD Files folder. Both defaults can be changed by clicking on the
Location button.

7 Click Run at the Set Up view.

Running BD Calibrite Beads

For LW and LNW assays, BD FACSComp software automatically adjusts PMT voltages
and fluorescence compensation, and evaluates instrument sensitivity using

BD Calibrite beads. FL4 adjustments apply only to a BD FACSCalibur or BD FACSort
flow cytometer equipped with the FL4 option.

Adjusting PMT Settings

At the PMT view, the software automatically adjusts the PMT settings for SSC, FL1,
FL2, and FL3 so that the unlabeled beads have a mean value (plus or minus 2) that
meets the established target values encoded in the software. If you included APC beads,
for cytometers equipped with the FL4 option, the FL4 PMT voltage is set using APC
beads, placing the beads in the target channel for FL4.

1 Gently invert tube A, and install it on the cytometer.

2 Set the sample flow rate to HI and the fluid control to RUN.

3 Click Start to begin PMT adjustment.
The acquisition display and Detectors/Amps window appear. An initial 5,000
events are acquired, a gate is set on singlet events, and the software starts
automatic PMT voltage adjustments.
The software automatically adjusts the PMTs in this window to place the beads in
their respective target channels. Controls in the Detectors/Amps window are

disabled during automatic adjustment. When the PMTs are set, checkmarks
appear next to the target values and the message PMTs Set Successfully appears.
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If APC beads are detected, the software automatically advances to the Time Delay
Calibration view. If APC beads are not detected, the software advances to the
Compensation view.

Performing Time Delay Calibration

A message indicates time delay calibration is being performed. Another message will
notify you of a successful calibration, after which the software will automatically move
forward to the Compensation View. The software will attempt the time delay
calibration three times before reporting any errors. After the third attempt, if it cannot
calibrate, an error message will appear. At that point you will have the option of going
back to the PMT View, continuing on to the Compensation View, or retrying
calibration.

Performing Time Delay Calibration

Adjusting Compensation Settings

Many of the fluorescent dyes used in flow cytometry have overlapping emission spectra.
Optical filters inside the instrument minimize the overlap of these signals but do not
completely eliminate them. BD FACSComp software determines the amount of
compensation needed for this remaining spectral overlap so that the unwanted signal
can be electronically subtracted from the signal of interest.

At the Comp view, BD FACSComp software adjusts fluorescence compensation using a
mixture of unlabeled, FITC, PE, PerCP, and APC beads.

1 Remove tube A from the cytometer.

2 Gently invert tube B, and install it on the cytometer.

3 Click Start to begin compensation adjustment.
The software adjusts the appropriate compensation networks to remove the
overlapping fluorescence, based on the beads detected by the software and the Lot
IDs that were entered in the Set Up view. During automatic adjustment, no other

action can be taken. When compensation is complete, an alert is sounded and the
software displays the message Compensation Set Successfully.
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Performing Instrument Sensitivity Testing

The Initial Sensitivity Test view appears after compensation has been set.

At the Sens view, BD FACSComp software checks the sensitivity of the cytometer.
During this test, the software measures the signal separation for each parameter and
compares this value to an expected separation value. This test will help ensure that the
cytometer is capable of detecting negative, dim, and bright populations for the
fluorescence channels and that noise is at a minimum for the scatter channels.

The Sensitivity Test consists of three different tests: the Fluorescence Sensitivity Test, the
Side Scatter Sensitivity Test, and the Forward Scatter Sensitivity Test. The Fluorescence
Sensitivity Test acquisition display appears.

Fluorescence Sensitivity Test

The software acquires 10,000 events and calculates fluorescence separation between the
means of the unlabeled and labeled beads in the FL1, FL2, and FL3 channels. FL4
sensitivity is measured by calculating the separation between the means of the PerCP (or
PerCP-CyS5.5) and APC bead signals in the FL4 channel.

Side Scatter Sensitivity Test

The cytometer produces an electronic test pulse in the FSC parameter. BD FACSComp
software acquires 10,000 events, locates the upper test pulse peak channel, then
acquires data for the side scatter Sensitivity Test. The separation between noise and the
side scatter signal of the beads is calculated. When this is complete, the test pulses are
automatically turned off (BD FACSort and BD FACSCalibur flow cytometers), or you
are prompted to turn them off (BD FACScan flow cytometer), and the forward scatter
Sensitivity Test begins.

Forward Scatter Sensitivity Test

For this test, the electronic test pulse is turned off. The software searches for the upper
level of FSC noise by lowering the FSC threshold. After it finds the noise level, the
software sets the threshold, acquires 10,000 events and calculates the separation
between the threshold and the mean channel FSC signal of the beads.

1 Remove tube B and place a tube with 1 mL of distilled water on the cytometer.
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Reviewing the Summary Report

When the Sensitivity Test is complete, the results are calculated, the Calib File. LNW is
saved in the Instrument Settings Files in the BD Files folder, and the Summary Report
view appears.
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Results are displayed in the Summary Report view in a scrollable window. The display
contains histograms, the separations for each parameter, instrument settings, blue laser
operation levels, the Sensitivity Test results, and other information.

The first section of the report displays the results of the Sensitivity Test. A minimum
separation is encoded in each bead lot ID for each parameter. The test result is either a
pass or a fail. If the channel separation is greater than or equal to the bead lot-specific
minimum channel separation, the parameter will pass the Sensitivity Test.

Scroll down to the bottom using the slider on the right of your window to view the
Sensitivity Test result plots which correspond with the High and Low separation values
at the top of the report.

The second section of the Summary Report displays the instrument settings that are
generated during the software run. It is a good idea to compare the detector voltages
and compensations settings from day to day to check for instrument stability. It is also a
good idea to log or export the Summary Report data and also keep a hardcopy of the
Summary Report in a binder.

For instruments equipped with the FL4 option, the comments section indicates the
results of time delay calibration.

The Summary Report is a PDF file that can be opened and printed by Adobe® Acrobat
Reader or any software that reads PDF files.
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1 Print the Summary Report.
A copy of the report is printed when you do one of the following.
¢ Quit the software
¢ Click Optimize to proceed to the Optimization view
¢ Choose File > Print

You have completed a lyse/no-wash assay setup run. To practice optimization with
biological samples, continue with the next section.

Optimizing Settings for Biological Samples

At the optimization view, you can use stained samples to fine-tune instrument settings,
if necessary, before launching your acquisition and analysis application (eg,

BD Multiset or BD CellQuest Pro software). BD FACSComp software provides five
default Optimization options, each associated with a default instrument settings file.

You can change the display at the Optimization view to any Optimization option by
clicking the pop-up menu located below the left-most plot. The plot parameters change
to reflect the new option, and the associated instrument settings are downloaded to the
cytometer. You can also create your own Optimization options.

v Optimization 1: Save File Name = MultiTEST.opt
Optimization 2: Save File Name = TriTEST.opt
Optimization 3: Save File Name = Simultest.opt
Optimization 4: Save File Name = ProCOUNT.opt
Optimization 5: Save File Name = Fastimmune.opt

In this tutorial, we will use a sample stained with BD Multitest reagents to optimize
SSC and FL3 threshold settings as our example.

1 Click Optimization in the icon bar.

2 Verify Optimization 1: Save File Name = MultiTEST.opt is chosen from the pop-
up menu. See Figure 1-2 on page 10.
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Figure 1-2 Optimization view

The Calib File.LN'W instrument settings are automatically sent to the cytometer
and used as the initial settings. MultiTEST.opt is the name of the instrument
settings file that is saved once optimization is complete and you click Save
Optimized Settings. The file is saved in BD Files/Instrument Settings Files.

3 Place the optimization sample tube on the cytometer.

Place a sample stained with BD Multitest— or BD Tritest-stained reagents on the
cytometer.

4 Click Start.
The plots display live data and the instrument setting controls are available.

5 While viewing the FL3 vs SSC plot, adjust the side scatter PMT to optimize the
position of the populations of interest, if necessary. See Figure 1-3 on page 11.

6 While viewing the FL3 vs SSC plot, adjust the FL3 threshold to exclude most of
the debris, if necessary.
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Figure 1-3 Optimized SSC and FL3 threshold settings
7 Click Save Optimized Settings.

If MultiTEST.opt settings already exist, click Rename or Overwrite. The new
optimized settings are saved.

8 Remove the sample tube from the cytometer and place a tube with 1 mL of
distilled water on the cytometer.

You have completed the optimization tutorial. Continue with the next section to
practice using online help.

Using Help

When you need assistance with BD FACSComp software, use the Help viewer to
quickly locate the information.

1 From the Help menu, choose FACSComp Help.

8686 BD FACSComp Help =] |
- Q| | vill Help Center
|| 3 AjrPort Help

Ask a Question

Back Help Center
J AppleScript Help

@ BD CellQuest Pro Help

i BD CloneCyt Plus Help

Il BD FACSComp Help

W BD MUILISET Help

& BD WorklistManager
DVD Player Help

3 iMovie Help

Welcome ) iTunes Help

X Mac Help

Q QuickTime Player Help

The fastest way to search for help is to use the Ask a Question feature. You can
also search by looking through the table of contents or index.
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2 Enter sensitivity test in the Ask a Question field; press Return.

A list of topics appears in the lower portion of the Help view. Double-click on a
topic to go to that section of Help.

eoce Search Results

—
& m Q_ sensitivity test

Back Help Center
47 topics found
Topic
Sensitivity Test
Lyse/Wash and Lyse/No-Wash Assays I
Summary Report plots after ...uccessful Sensitivity Test NI
Index iy
BD FACSComp Help TR
Manual PMT and Compensation Adjustments Ly
LW and LNW Assays Ly
Troubleshooting i
Limitations v
Application Window mrmn
Summary View Ly
Compensation Adjustment LI
Using BD CaliBRITE Beads L]

Ask a Question

Relevancew Location
[ g 8D FACSComp Help

[ BD FACSComp Help
& BD FACSComp Help
Iih 8D FACSComp Help
I 8D FACSComp Help
& BD FACSComp Help
[ BD FACSComp Help
Ik 8D FACSComp Help
Il 8D FACSComp Help
I 8D FACSComp Help
[ BD FACSComp Help
[ BD FACSComp Help
I BD FACSComp Help
i o raree P

3 When you are finished, close the Help viewer by clicking the red button in the

upper-left corner of the viewer.

4 Click Quit to exit the software

BD FACSComp Software Tutorial

336483 Rev. A



	BD FACSComp™ Software Tutorial
	Preparing BD Calibrite Beads
	Performing Lyse/No-Wash Assay Setup
	Entering Information in the Sign In and Set Up Views
	Running BD Calibrite Beads

	Optimizing Settings for Biological Samples
	Using Help

